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Building a Simple Model 

This section explains how to build a simple Simulink model that displays a sine wave in a 
scope. For more detailed information on building models, see the Simulink documentation. 

The Basic Steps 

This section describes the basic steps in building a model. It explains how to 

 Set simulation parameters with commstartup 

 Open a new model window 

 Open block libraries 

 Move blocks into a model window 

 Connect the blocks 

 Set block parameters 

 Set simulation parameters 

 Run the model 

Building a model usually involves several iterations, as you decide which blocks to include 
and what parameter settings to make. In the example in this section, you will refine the model 
by adding noise. The section explains how to 

 Add noise to the model 

 Save the model 

The section also explains 

 Frames and frame-based processing 

 Discrete signals and sample times 

 Continuous signals 

Using commstartup to Set Simulation Parameters 

Before starting to build the model, enter 

commstartup 

at the MATLAB prompt. 

This 

 Sets the Simulink Boolean logic signals parameter to Off 

 Sets default simulation parameters that are optimal for communications 

models 

The Communications Blockset does not support signals with boolean data types. If 

you want to use Simulink blocks that output boolean data types, such as the Logical 

Operator block, in a model with blocks from the Communications Blockset, enter 

commstartup before building the model. The commstartup settings apply to any 

models you create during the current MATLAB session. You must enter 

commstartup at the beginning of each MATLAB session to establish these settings. 

http://www.mathworks.com/access/helpdesk/help/toolbox/commblks/gs/fp60152.html
http://www.mathworks.com/access/helpdesk/help/toolbox/commblks/gs/fp50153.html
http://www.mathworks.com/access/helpdesk/help/toolbox/commblks/gs/fp50246.html
http://www.mathworks.com/access/helpdesk/help/toolbox/commblks/gs/fp55155.html
http://www.mathworks.com/access/helpdesk/help/toolbox/commblks/gs/fp8551.html
http://www.mathworks.com/access/helpdesk/help/toolbox/commblks/gs/fp5699.html
http://www.mathworks.com/access/helpdesk/help/toolbox/commblks/gs/fp32012.html
http://www.mathworks.com/access/helpdesk/help/toolbox/commblks/gs/fp24479.html
http://www.mathworks.com/access/helpdesk/help/toolbox/commblks/gs/fp48311.html
http://www.mathworks.com/access/helpdesk/help/toolbox/commblks/gs/fp19494.html
http://www.mathworks.com/access/helpdesk/help/toolbox/commblks/gs/fp55024.html
http://www.mathworks.com/access/helpdesk/help/toolbox/commblks/gs/fp55016.html
http://www.mathworks.com/access/helpdesk/help/toolbox/commblks/gs/fp55016.html#fp25190
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If you build a model without entering commstartup and subsequently decide to use Simulink 

blocks that output signals with boolean data types, turn off the model's Boolean logic 

signals parameter by entering 

set_param('my_model', 'BooleanDataType', 'off') 

where my_model.mdl is the name of the model. 

Opening a New Model Window 

The first step in building a model is to open a new model window. To do so, select New from 
the File menu, and then select Model. This opens an empty model window, as shown in the 
following figure. 

 

Opening Block Libraries 

The next step is to select the blocks for the model. These blocks are contained in libraries. To 

view the libraries for the products you have installed, type simulink at the MATLAB prompt 

(or, on Microsoft Windows, click the Simulink button  on the MATLAB toolbar). If you are 
using Microsoft Windows, this displays the Simulink Library Browser, as shown below. 

Simulink Library Browser 
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The left pane displays the installed products, each of which has its own library of blocks. To 
open a library, click the + sign next to the name of the blockset in the left pane. This displays 
the contents of the library in the right-hand pane. 

You can find the blocks you need to build models of communication systems in the libraries of 
the Communications Blockset, the Signal Processing Blockset, and Simulink. 

Moving Blocks into the Model Window 

The next step in building the model is to move blocks from the Simulink Library Browser into 
the model window. To do so, 

1. Click the + sign next to Signal Processing Blockset in the left pane of the Library 
Browser. This displays a list of the Signal Processing Blockset libraries. 

2. Click DSP Sources in the left pane. This displays a list of the DSP Sources library 
blocks in the right pane. If you do not see the Sine Wave block, scroll down the list 
until it is visible. 

3. Click the Sine Wave block and drag it into the model window. 

4. Click DSP Sinks in the left pane of the Library Browser. 

5. Scroll down in the right pane of the Library Browser until you see the Vector Scope 
block, and drag the block into the model window to the right of the Sine Wave block. 

Once a block is in the model window, you can move it to another position by dragging the 
block with the mouse. 

Dragging a Block into a Model Window 
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Connecting Blocks 

The small arrowhead pointing outward from the right side of the Sine Wave block is an output 
port for the data the block generates. The arrowhead pointing inward on the Vector Scope 
block is an input port. To connect the two blocks, click the output port of the Sine Wave block 
and drag the mouse toward the input port of the Vector Scope block, as shown in the 
following figure. 

 

When the pointer is on the input port of the Vector Scope block, release the mouse button. 
You should see a solid arrow appear, as in the following figure. 

 

If you do not see a solid arrowhead, you have not made a connection. In this case, click the 
arrowhead again, drag it all the way to the Vector Scope's input port, and release the mouse 
button. 
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Setting Block Parameters 

To set parameters for the Sine Wave block, double-click the block to open its dialog, as 
shown in the following figure. Change the following parameters by clicking in the field next to 
the parameter, deleting the default setting, and entering the new setting in its place: 

1. Set Amplitude to 5.  

2. Set Frequency to 30.  

3. Set Samples per frame to 100. 

4. Click OK.  

Note    You must set Samples per frame to a value larger than 1 to see an 

image of the sine wave in the Scope block. 

         

Dialog for the Sine Wave Block 

 

Setting Simulation Parameters 

Besides individual block parameters, the model also has overall simulation parameters. To 
view the current settings, 

1. Select the Simulation menu at the top of the model window. 

2. Select Configuration parameters to open the Configuration Parameters dialog 
box, as shown in the following figure. 
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Configuration Parameters Dialog Box 

 

If you typed commstartup before creating the model, the Stop time should be set to inf. The 
Stop time determines the time at which the simulation ends. Setting Stop time to inf causes 
the simulation to run indefinitely, until you stop it by selecting Stop from the Simulation 
menu.  
The Stop time is not the actual time it takes to run a simulation. The actual run-time for a 
simulation depends on factors such as the model's complexity and your computer's clock 
speed. 
The settings in the Configuration Parameters dialog box affect only the parameters of the 
current model. 

Running the Model 

Run the model by selecting Start from the Simulation menu. When you do so, a scope 
window appears, displaying a sine wave as shown in the following figure. 

Sine Wave Displayed in a Scope 
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Adding Noise to the Model 

You can add noise to the model using the AWGN Channel block, from the Channels library of 
the Communications Blockset. The block adds white Gaussian noise to the sine wave. Move 
the block from the Simulink Library Browser into the model window, as described in Moving 
Blocks into the Model Window. You can add the block to the model as follows: 

1. Extend the line between the Sine Wave block and the Vector Scope block by 
dragging the Vector Scope block to the right, to make room for the AWGN Channel 
block. 

2. Click the AWGN block and drag it onto the line. This automatically connects the Sine 
Wave block and the Vector Scope block to the AWGN Channel block. 

Sine Wave Plus Noise 

 

Double-click the AWGN Channel block to open its dialog, as shown in the following figure. 

Then, click the down arrow in the Mode field and select Signal to noise ratio (SNR). 

Dialog for the AWGN Channel Block 

 

Now when you run the model, the scope clearly shows the added noise. 

 

 

http://www.mathworks.com/access/helpdesk/help/toolbox/commblks/gs/fp55155.html
http://www.mathworks.com/access/helpdesk/help/toolbox/commblks/gs/fp55155.html
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Sine Wave with Noise Added 

 

When you are finished observing the simulation, stop the model by selecting Stop from the 
Simulation menu. 

Saving a Model 

To save your model for future use, select Save from the File menu. The first time you save 
the model, this displays the Save As dialog box. In the Save in field, select the directory 
where you want to save the model. It is best to keep your work files in a separate directory 
from the files shipped with the product. In the File name field, enter a name for the model, 

such as sine.mdl, and click Save. 

To load the model in a future MATLAB session, first change your working directory to the one 
where you saved the file. You can do this by selecting the directory in the Current Directory 

field on the MATLAB toolbar. Then enter sine in the MATLAB Command Window. 

Frames and Frame-Based Processing 

A frame is a sequence of samples combined into a single vector. By setting Samples per 

frame to 100 in the Sine Wave block, you set the frame size to 100, so that each frame 

contains 100 samples. This enables the Vector Scope block to display enough data for a 
good picture of the sine wave. 

Another important reason to set the frame size is that many Communications Blockset blocks 
require their inputs to be vectors of specific sizes. If you connect a source block, such as the 
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Sine Wave block, to one of these blocks, you can set the input size correctly by setting 
Samples per frame to the required value. The model described in Reducing the Error Rate 
Using a Hamming Code shows how to do this. 

In frame-based processing all the samples in a frame are processed simultaneously. In 
sample-based processing, on the other hand, samples are processed one at a time. The 
advantage of frame-based processing is that it can greatly increase the speed of a simulation. 
If you see double lines between blocks, the model uses frame-based processing. 

Discrete Signals and Sample Times 

The Sine Wave block in the Signal Processing Blockset generates a discrete signal. This 
means that it updates the signal at integer multiples of a fixed time interval, called the sample 
time. You can set the length of this time interval in the Sample time parameter in the block's 
dialog. In the example described in Building a Simple Model, the Sample time has the default 

value of 1/1000. All the sources in the Communications Blockset and the Signal Processing 

Blockset generate discrete signals exclusively. These sources are primarily designed for 
modeling digital communication systems. 

Continuous Signals 

The Simulink libraries also contain blocks that generate continuous signals. This means that 
they update the signal at variable time intervals, whose length is determined by the numerical 
solver the simulation uses. For example, the Sine Wave block in the Simulink Sources library 
can generate a continuous sine wave. 

Now try to construct this model 

 

 

http://www.mathworks.com/access/helpdesk/help/toolbox/commblks/gs/fp6412.html
http://www.mathworks.com/access/helpdesk/help/toolbox/commblks/gs/fp6412.html
http://www.mathworks.com/access/helpdesk/help/toolbox/commblks/gs/fp65247.html

